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Modify the Method of Response Not the Task 
 

Universal Design for Learning   http://www.cast.org/publications/UDLguidelines/version1.html 
Multiple ways of acquiring knowledge and information/ Multiple means of expression providing 
learners with different ways of showing what they know/ Multiple ways of engaging students to tap 
interests & increase motivation  
Why do we give students tasks? Varies subject to subject & lesson to lesson.  In general to: - assess 
writing skills, assess knowledge & ideas on a topic, help learning by doing or researching, or if we are 
honest, sometimes to keep them busy.   
Don’t Modify the Task   For years this has been the traditional means of accommodation for many 
students. For some intellectual or physical difficulties it may still be the answer, but for many with 
difficulties such as dyslexia it is not the best approach.  It is demeaning, encourages students to give 
less than their best and an incomplete answer, and means from the outset they cannot get credit for 
complete answer, so basically they have often failed in their eyes, before they begin.  It also encourages 
“learned helplessness” which is extremely hard to break once learned.  
“Don’t judge what I can do by what I can’t do!” Many Specific Learning Difficulties (SLD) 
students are average or above average intelligence, verbally/ spatially very astute & think very laterally.  
Modify the Means of Response   Now, it is easy to record sound, photos, video, diagrams and written 
words in so many ways.  By the use of digital portfolios - these methods of response can all be stored 
and also send home in reports.  
C 19th Education System   Many teachers are still scared of technology and frequently unaware of the 
possibilities. Students – on the other hand seem to be born with a mouse in their hands & speakers in 
their ears.   The student reaction to a button is “push to see what will happen”. The teacher reaction is 
still frequently, “What terrible calamity will occur if I push that?” ‘Our students have changed 
radically. Today's students are no longer the people our educational system was designed to teach. 
They think and process information fundamentally differently from their predecessors. The single 
biggest problem facing education today is that our Digital Immigrant instructors, who speak an 
outdated language (that of the pre-digital age), are struggling to teach a population that speaks an 
entirely new language. Digital Natives, Digital Immigrants Marc Prensky On the Horizon (NCB University Press, 
Vol. 9 No. 5, October 2001  
Universal Design SLD students do not need to feel different.  Give the whole class a choice of 
response.  Students can now be judged on their ideas not their writing ability.   SLD students can get 
the credit they deserve.  
Advantages of Multimodal Responses At least 25% of the world’s millionaires are dyslexic.  Many 
of the great brains and really creative people of the world are dyslexic. We need to stop excluding the 
lateral thinkers from education. If we are to improve school retention rates and keep students truly 
interested and involved, we need to make education more exciting for all - teachers included. 
Assessment   Teachers, students & parents need to push the boundaries.  Many education departments 
and exam boards need to be dragged from C 19th to C 21st.  Unfortunately- litigation or threat thereof 
will force the issue.  Enlightened class room teachers need to lead.  We need to consider what we are 
assessing and find ways to assist students who have reading and writing difficulties to be assessed on 
the subject under question not limited by their disability.  There is plenty of technology now available 
to do this.  
Why   Some student’s writing, reading ability will never keep pace with their cognitive ability. 
Research shows multi modal approaches: keep students’ interest, attendance is more regular, behaviour 
is less of an issue and teacher enthusiasm increases.  It does not decrease natural reading/ writing 
ability, in fact, research shows it actually improves it 



WHEN   Start young, don’t wait until learning difficulties are compounded by behaviour issues, self 
esteem problems and boredom.  Young students are not usually self conscious – love recording their 
own voice, having their photo taken and don’t think their artwork “sucks”.  Use additional technology 
at the same time as we teach them to read and write.  This keeps students with their peer group instead 
of dropping behind and playing “catch–up” for the rest of their life.  
WHAT  Morning talks, picture talks, recount stories, debates, verbal presentations, sequencing 
activities, drama, 3D models, artwork, prose, poetry , song etc. 
Skills Needed  

• Analyse task – what is required   • Key words for research   
• Plan – graphic best for most – particularly when learning   
• Encourage variety in response – teach IT skills needed – to all  

Analyse task – what is required? Restate task in their words: - class activity in early years from 
which all students will benefit.  If verbal, written or graphic restatement of task is submitted before 
major work begins, students on the wrong track can be re directed before they waste time.  
Key words for research  When learning make this a class activity: - great on an interactive whiteboard 
especially using encyclopaedia or web link.  Helps teachers and students if they record (text or audio) 
key words and phrases used to search.  Helps develop library & internet skills.   
Plan Graphic plan best for most – particularly when learning.  Inspiration good - easy to use. Tech free 
approach, try Sticky notes: - write one idea on each- then move into groups.  Try planning as a class 
activity; it encourages diversity of thought.  Ask students to submit their plan with their work – helps in 
assessment.   A good plan is the basis for all forms of response: - videos, Power Points, essays, audio 
responses and Podcast.  
Encourage variety in response teach IT skills needed to all   Celebrate diversity in response - makes 
life as a teacher far more interesting.  Request multi modal responses from all- improve skills in less 
preferred areas. Group work takes on a different meaning- students have very different abilities in 
different areas and can really learn from each other.  
Different Methods of Response 

• Traditional written response using writing, typing, word prediction, voice reproduction etc  
• Sound File + graphic plan = easy to assess.  Tape recorder, windows sound recorder, Text Ease, 

Power Point etc.  Teach to record their voice from Year 1.  
• Power Point Presentation.  Either with commentary or with captions.  
• Movie. Video recorder, Windows Movie Maker, Photo Story 3 etc (commentary or captions) 
• Blog, Podcast, Vodcast  
• Art.  Drawings, diagrams, 3D models, computer art etc.   

Audio Age Educators   Most students need help to develop skills to be good “speakers”. Most of the 
skills needed to write a good essay are needed to make a good speech. (Don’t need writing/ spelling.)   
Graphic plan + audio essay is easy to assess.  Many programs available to record sound.  (Audacity, 
Sound Recorder, MP3 recorder etc, Windows Movie Maker, Power Point etc)  
Main skills needed: - Clear enunciation, reasonable speed – not too fast or too slow, speak in whole 
sentences or at least phrases, ability to work from a dot point list or graphic plan to organise thoughts.   
One of the best programs for younger students is Text Ease: - gradual development from speech to 
typing, student can write from their own dictation, publish talking books- dictate their own story then 
type it, import their digital photos/ videos and add a commentary, talking dictionary, text to speech and 
customisable word lists.   
Speech to Text or Voice Reproduction 
Technology available to turn talk into type (Dragon Naturally Speaking V 10 Preferred is best).  



Usually don’t introduce until 10/11years of age. Introduce after they can dictate effectively. Not an 
instant cure but lifetime tool. Not an answer for all but a “miracle” for some. It doesn’t make spelling 
errors only recognition errors. Regular speech defects can be accommodated.  
Web 2 Tools  
Because of dangers and negative publicity of “open” social networking sites (My Space/ Facebook) 
many educators overlook the positive values.  A well supervised, closed class web space is an excellent 
way to help teachers and students develop 21st Century skills, many more reticent students appreciate 
the “anonymity” of working at a screen instead of contributing in class, slower thinkers appreciate time 
to think before responding, for many students it is seen as “cool” and can be used effectively for 
homework, save class time and provide a brilliant way of publishing and communicating beyond the 
classroom walls.  

• Blog- (contraction of “weblog”) Website - regular entries (usually reverse-chronological order) 
Commentary, ideas, news on particular subject, personal online diaries. Combine text, images, 
videos, links to other blogs, web pages, and other media related to its topic (most primarily text). 
Readers can leave interactive comments.   
• Pods (combination of broadcast & I Pod) an audio file delivered over the internet.  
• Vodcasts = video delivered over the internet watched on a PC, TV or mobile media device.  
• Social Networking Sites= Focus on building online communities of people who share interests 

and/or activities.  Web based - provide ways for users to interact- e-mail, instant messaging.  
New ways to communicate and share information.  

• Virtual Reality Games = real life scenarios on line to solve problems.  
“Soft Cop - Cheating”   
Alternative forms of response are often seen as easier.  They are not easier and often take longer and 
require just as much research as more traditional forms of response. The ideas expressed are equally 
valid and the responses are frequently more interesting to do and assess.  Many of these alternative 
forms of response incorporate the use of 21st century skills which are so much an integral part of 
modern society and crucial to future of employment of our students.     
Traditional essay writing skills are just as important whether the work is dictated or written, is a formal 
essay or a film commentary.  Students still need to learn about introductions, conclusions, paragraphs, 
linking ideas, conjunctions flow of ideas etc.  A greater percentage of the class will be more attentive if 
you are teaching these skills in regard to making a film commentary than if you are talking about 
writing a formal essay.  
It is the ideas that are important not the way they are recorded  
Electronic literacy has the potential to make specific learning difficulties like dyslexia, a thing of the 
past.  It has the potential to make the learning playing field more level so that it is our understanding 
and ideas we are judged on, not our ability to decode or encode symbols. Technology cannot fix or 
eliminate learning difficulties but it can help capitalise on strengths and bypass weaknesses.  With the 
right software, students can develop independence, reduce demeaning reliance on others and be 
motivated to achieve things on their own. The technology is ready and waiting.  Are we, the educators, 
adaptable enough to accept the challenge?  
“As technological changes move our culture from a world of written words to a world of computer 
images, we need to reassess the kinds of educational goals we have.  In many cases we may be pleased 
to find that the changes favour the talents many dyslexics have while they make dyslexic difficulties less 
and less important.”     Thomas G West            Visualisation Research Washington  
  
 
 



 

 

Useful Software  
Free 
Audacity – record voice files http://audacity.sourceforge.net/about/  (download & install the LAME file 
as well to do MP3 files)  
Ask & Record Toolbar http://applian.com/asktoolbar/  Record, download & convert all sorts of audio & video files.  

Post it Notes Lite  http://download.cnet.com/Post- it-Digital-Notes/3000-2351_4-10060027.html  
Power Talk  http://fullmeasure.co.uk/powertalk/  Read information - needs SAPI 5 free download  
Power Bullet http://www.powerbullet.com/ free version of power point.  
Photo Story 3http://www.microsoft.com/windowsxp/using/digitalphotography/photostory/default.mspx   
Windows Movie Maker http://www.microsoft.com/windowsxp/downloads/updates/moviemaker2.mspx  
Word Talk http://www.wordtalk.org.uk/Home/  Makes MS Word talk and converts text to audio file.  
Purchase  
Text Ease Essentials   $125.95 http://www.speld-sa.org.au/sat/index.html NZ $163. http://www.edsoft.co.nz   

2 Create A Story A$85 http://www.2simple.com.au/2createastory/  $NZ 106.60 NZ – InfoTech Education 
– http://www.infotech-education.co.nz/  contact person Sherry Chrisp   
Story Book Weaver $159.95 (5 user Lic) http://www.east-west.com.au/catalog/product_info.php?products_id=736  
Easiteach + Text Ease Studio http://www.manzana.co.nz/html/solutions_software.php?sector=educ  
Edsoft 1300 337 638  ,  Sitech Systems NZ Ltd  Freefone 0800 100 607, Manzana Limited +64-9-440-9988 
Easiteach single user ranges from NZ$184 for the basic tools to NZ$760 for the full set. Content packs NZ$344. 
Useful “How to… “  Files 
Increase the Maximum Recording Time in the Sound Recorder Utility http://support.microsoft.com/kb/q82215/   

Record Sound in Power Point   Win XP http://iit.bloomu.edu/vthc/PowerPoint/Sound/record.htm   
http://presentationsoft.about.com/od/powerpoint2007/ss/07recordsound.htm   
Record Sounds with Audacity  http://audacity.sourceforge.net/manual-1.2/tutorial_basics_4.html  
Record Sounds in Text Ease   http://softease.rm.com/Catalogue.aspx?cid=4  
Recording Narration Windows Movie Maker http://www.windowsmoviemakers.net/Tutorials/HowToAddNarration.aspx 
Use Photo Story 3    http://www.microsoft.com/windowsxp/using/digitalphotography/photostory/tips/firststory.mspx    
Create your own Podcast  http://reviews.cnet.com/4520-11293_7-6246557-1.html   
Project Based Learning    Provides complex tasks based on challenging problems that involve 
students' problem solving, decision making, and investigative skills.   Focuses on questions that drive 
students to encounter the central concepts and principles of a subject hands-on 
 http://pbl -online.org/   ( Type Project Based Learning into a search engine)  
  



 

 

MS Word – Features We Often Miss 

Word Talk 

Free download from http://www.wordtalk.org.uk/    (Read FAQ’s) for use with all versions of 
Microsoft Word (Word 97 upwards), which speaks the text of any MS Word document and highlights 
it as it goes. It also contains a talking dictionary, spellcheck and text to audio. You can adjust highlight 
colours, voice and speed. Specialised programs do this but are frequently too expensive or have too 
many functions for many users.  System Requirements:Microsoft Windows PC (Windows 98 + including Vista) Microsoft Word or 

Microsoft Office (with Word installed) (97+ )  Download using broadband, as WordTalk.msi is large You can also 
download a PDF of instructions from the Word Talk site. In Word 2007 the Word Talk toolbar appears 
under Add Ins and needs to be clicked open each time Word is opened.  

MS Word  Modifiers  keys = Control (Ctrl) on PC and Command (Cmd) on Mac. To simulate a right 
mouse click on Mac, hold down ctrl as you click your mouse. 

Text to Speech     Students with reading difficulties can use text to speech to read textbooks and 
worksheets. Most struggling writers find it helpful to have text read aloud to review and proof read to 
check for accuracy and sense.    

PC - Download Word Talk (free)  

Mac – Select Speech from Services menu of most applications and computer starts speaking! OR To 
hear selected text:  Choose Apple menu /System Preferences/ Speech/Text to Speech/ Select “Speak 
selected text when key is pressed” checkbox.   Type modifier key (Command, Shift, Option, or 
Control) and another key to set keys to hear selected text.  Click OK when combination you typed 
appears in text field. 
Text to Audio File 
Modern students use audio files to access information much more than printed text.  To keep pace we 
will have to use this technology in educating the students of today.   
 
Visual Changes 
Changing text size, font and colours  
Adjust Word to suit particular colour preferences or visual or perceptual difficulties. Simple changes to 
font, size and colour can make a huge difference to the readability of text.  To change:   Format / 
Background choose colour.      (2007 Page Layout/page colour)  Edit /Select All (CTRL-A), Format 
/Font/ choose colour, size and style.  (2007 home/select/ hover to preview/ click)  
Zoom – View/ zoom does not affect printing. Change page setup margins to avoid scrolling from side 
to side- (change back before you print)  (2007 zoom scroll right task bar)  
Line Spacing - increase white space between lines to assist tracking. Increase page margins to reduce 
line length.  Keyboard commands are often easier to use than mouse Keyboard shortcuts for paragraph 
formatting:CTRL+1 Single-spaced paragraph,  CTRL+5 1 1/2-line paragraph spacing, CTRL+2 
Double-spaced paragraph  
Format /Font/Character Spacing/ select Spacing/ choose Expanded/ set distance between each letter 
Format/ Paragraph/ select Line Spacing/ set distance (2007 shortcuts work Page layout/ spacing/ 



 

 

paragraph/indents & spacing/ line spacing.  Home/ Font/ Character Spacing – click expanded or 
condensed and specify using By box)  
 
Clear Formatting from Text Pasted into MS Word   When you copy text to insert into a document, 
you may not want formatting associated with the text.  To remove,  Copy and paste text into Word, 
look down the end of copied data on right for a small clipboard click/ choose “keep text only”.  
Highlighter   Use to pick out key sections for students who struggle with reading.  Students can use 
highlights to mark important points as they read so they can find them again easily.  Turn on View/ 
Toolbars/ Formatting. Click at right hand side to choose colour then highlight text.  Use different 
colours for different types of information.  Show none to delete highlighting. 
(2007 Home/ Font / Highlighter hover & select.  Select text then No colour to remove highlight. )  
 
Spelling    
Most poor spellers find the talking spellchecker from Word Talk more useful than MS Word’s 
spellchecker. Word can automatically check words as you type and underline suspect words with a red 
wavy line. To switch off auto spell/ grammar check: - go to Tools -> Options (Preferences Mac), click 
Spelling and Grammar tab, turn off Check Spelling as you type.  Usually better to spellcheck when 
you finish writing. Place cursor at start of document (CTRL+Home) click ABC button.  To check 
individual words right click an incorrectly spelled word - list of choices appears. Select correct word.  
 
AutoCorrect   Automatically replaces mis-spelling with correct word.  Suppose you always spell 'used' 
as 'yoost'. Click Tools > AutoCorrect. Type 'yoost' into 'Replace' box, and 'used' into 'With' box. Click 
Add/ OK to close AutoCorrect.  Now 'yoost' will automatically be replaced by 'used'.  You can add 
several mis-spellings, each with the correct spelling, to AutoCorrect.  E.g. if you spell 'anyone', as 
'enyone', 'enywon' or 'enywone', add all three mis-spellings to AutoCorrect, so whichever spelling you 
type, the correct word is typed into the text.  (2007 Review/ ABC/Options/ Auto Correct Options – at 
the top)  Use AutoCorrect to store abbreviations for difficult words, e.g. 'bourgeoisie'. Add with a short 
abbreviation you can remember and spell - 'brg' for 'bourgeoisie'.  When you type 'brg'+ space, 
'bourgeoisie' is inserted. Choose an abbreviation which is not a whole word – e.g. don’t use 'an' for 
'anthropology'.  
 
AutoText is designed for storing and retrieving words, phrases or graphics. E.g. add AutoText to type 
your address quickly. Type it out and copy to clipboard. Click Tools / AutoCorrect/ AutoText -first 
line shows as entry, and entire text shows in Preview.  Click Add.  Start typing the abbreviation and 
the phrase is offered in a box. To insert press Enter, otherwise press Esc.  
 (2007 The keyboard shortcuts for inserting and creating autotext are the same.  To insert existing 
autotext, type an autotext name, and press F3 to insert the autotext.  To create new autotext, type 
entry, select what you typed, press Alt+F3, give it a name. Or like the previous answer mentions, you 
can add the Autotext command to your Quick Access Toolbar. Microsoft Button/ Word Option/ All 
commands/ Auto Text and add)  
 
Thesaurus   Right click a correctly spelled word for synonyms.  Word thesaurus can help spell difficult 
words. Type “nice” highlight and right click /synonyms or Shift +F7 (Shift Command R for Mac).  
Right click/ insert or lookup to get more words.  This only works if you can think of short words that 
mean the same as the longer one you want. (2007 Shift + F7 , ABC Thesaurus, highlight, right click/ 
Synonyms/ Thesaurus)   
 



 

 

Word Lists    Many dyslexic writers know which words they find difficult.  Get help to create a 
'dictionary' of these words and store on the hard disc.   Have lists for different subjects, or alphabetical 
lists (use MS Word table to create alphabetic lists).  When writing, copy and paste difficult words from 
the list into the document.   
 
Text Boxes  Go Insert/ Text box.   Copy & paste word list into text box.  Drag text box along as you 
work. Copy & paste required words to your writing. Text box floats over top of existing text and 
pictures. Use to label a graphic/picture.  Multiple boxes can be set up ahead of time with words already 
entered. (2007 Insert/ Text Box/ Simple        Use alphabet tool Home/ A/Z    to put in alphabetic order)  
 
Forms Menu   Lets you add fill in the blank fields, checkboxes and pull down menus into word 
document. View/ Toolbars/ Forms. (Third option from left is drop down form field). Make your first 
item a row of blanks so they need to click the list to see a selection  
Place the cursor where you want a drop-down list and click the drop down form field button. A grey 
box appears.  Double click the grey box and a dialogue box opens. Insert words you want in the list by 
typing them in the drop-down item box. Make the first item blank by using the space bar.  After each 
word click the Add button. This adds your word to the drop-down list and it appears in the Items in 
drop-down list box.  When you finish adding words click OK [bottom right on the dialogue box]. 
Drop-down lists only work when the document is protected so click Protect form button on form 
field task bar. To edit the form the protect button needs to clicked off.  Pupils need to unprotect the 
document to add text answers but their drop-down selections are not lost if they do this. .  If they can’t 
read the options teach them to make a choice, have the voice read it aloud and change if it is incorrect.    
(2007- Click Microsoft Office Button/ Word Options/Popular and select Show Developer tab in the ribbon and click OK.  
On Developer tab / Control group click Drop Down list. In the same box select Properties and click Add. Type your first 
choice in the Display Name box.  Repeat this stem until all the choices are in the drop down list.   
 
AutoSummarize  looks for keywords in a document and those sentences that contain keywords get put 
into a summary. In general it does fairly good job on reports, articles, scientific papers and Theses.  
It does not do well on fiction, most correspondence, and How-to instructions. With document open go 
Tools/AutoSummarize. The dialogue box lets you determine type and length of summary.  
(2007 The Auto Summarise tool needs to be added to the Quick Access Toolbar first.  Microsoft Button/ Word Options/ 
Customise/ All Commands- select Auto Summarise Tools and add.)  
 
Outline Features   Quick way to organize, reorganize and document, get an overview of bigger 
picture, move large blocks of text easily or collapse information in outline view to reduce clutter.  Use 
for electronic studying.  Select View/ Outline . Type title, press Enter.  Click green add sub-heading.  
Add text under by clicking double green arrow. Whole sections can be dragged to re-order the 
document.  Levels can be 'promoted' or 'demoted', and 'collapsed' or 'expanded' to show or hide 
underlying information. Click View/ Print Layout to convert to usual view of document and add more 
text at any point (2007 View/ Outline)  
 
Hyperlinks   Link to web pages, email, newsgroups, to help direct where a person should locate 
information.  Hyperlink to other Microsoft documents.  Hyperlinks can also be added to imported 
graphic files, clip art, digital pictures, and objects drawn using WordArt.   Teachers can reduce time 
students waste researching. Make talking books by linking separate word docs as separate pages, 
putting a hyperlink on the bottom right corner and using word talk to read aloud.(2007 Insert/ Hyperlink - 
select word & right click remove to remove hyperlink)  
 



 

 

Voice Comments (Need a microphone and speakers.) Voice comments are recordings attached to the 
document inside comment balloons. Voice Comments is Insert/Object, scroll to Wave Sound. Click 
Record. Close window and speaker appears in text to show there is a recording at that point.  
These are recordings not speech recognition – the computer does not convert them into text. 
(2007/  Cannot Make this Work at this stage)  
 
Insert Audio Note (Record Sound - Mac only) 
To record sound in Word on Mac you need to be in Notebook layout. Go View/ Notebook Layout. A 
toolbar appears that lets you record audio notes.  Can also access through Tools/ Audio Notes 
 
Dictionary: Download the free Word Web http://wordweb.info/free/  control + right click on any 
word will go straight to the dictionary.  
 



 

 

E-Text- The Way to Inclusive Education 
 

Walk a mile in my shoes…How often do we ask students to read information?   Whether asked to read 
aloud or silently, if they don’t know the code then they have little chance of reading the passage 

effectively. People are still frequently measured by their ability to read and write.    Those unable to access 
text by traditional means are labelled illiterate - frequently considered “dumb” or unintelligent. 

 
What is reading? Oxford: - “to study, interpret or give meaning to”.  Not just the ability to decode  

Once decoding is done SLD students can perform higher thinking skills as well as the next person 
Modern reading is increasingly 3D not linear.  Increasingly information in our society is passed on in 
auditory form, we listen and watch the news on TV we don’t read the paper, we use a mobile instead of 
writing a letter.   
Text to speech provides a means of including students with poor reading and writing skills in mainstream 
classes.  (They don’t fall behind or develop self esteem or behaviour problems so readily) 
Inclusive Technology can be used in conjunction with remedial software - works well.   
Multimedia Computers: - enable people to read by other means, translate text to words, Translate foreign 
text with a click, can unlock the mysteries of print for those previously “kept in the dark”.  The potential 

of text to speech:- basic decoding/ word definitions / cognitive prompts / simpler versions of text/ 
supplementary information/ key ideas highlighted/ graphic illustrations / change colour, size of page & 

print/ note taking 
RESEARCH SHOWS CLEARLY ASSISTIVE TECHNOLOGY DOES NOT CREATE DEPENDENCY- IT 

IMPROVES NATURAL ABILITY 
 

E-Text is any text stored in electronic format. Because it is stored electronically it is fluid: - can be edited, 
copied, pasted, read aloud, converted to audio & much more. 

Free E-text Readers, Little choice of voice usually computerised voice.  Often only read txt documents, 
Most won’t read web pages, won’t change pronunciation, limited highlighting options, won’t talk as you 

type 
Options: Word Talk, Natural Voice Reader, Read Please, MS Reader 

Mid Range E-text Readers, Some choice of voice – often pay for more voices, some choice of highlighting 
options , may read as you type , may read on the web 

Options : (Read Please, Natural Voice Reader- paid voices) Text Ease Studio - SPELD 
High End -  E-Text Readers ;- Real sounding voices- Aust accent, choice of highlighting style , choice of 

colour of background/ text, often linked with a scanner , often includes link with dictionary, thesaurus, 
often able to change pronunciation, often function to make audio books 

Options: Text Help Read & Write (Gold), Kurweil, CoWriter, Wynn   
Where to find E-Text;- Any Word Processor document is E-text, any text on the internet is E-text, any PDF 

file is E-text, any scanned document can be E-text  
How to Find E-Text Books   Go to Google type E-Text books - Qualify by adding words like “teen, 

children, adult, audio, free.  Be willing to play you will find your favourites. Some can only be read online.  
Others can be downloaded.  Websites – see separate sheet  

How to Make E-Books 
Software: - Storybook Weaver (graphics ), 2 Create a Story, Power Point (graphics + interactive)  
Text Ease (graphics + interactive), Word + Word Talk or Word + RMR.  MS Reader (Easy, free, real 
book format), Clicker 5 (Takes time to make), Windows Movie Maker (Win XP/ Vista)  

Tips & Tricks to Scanning E-Text  
• Need good OCR scanning software (Text Help Read & Write Gold, Abbyfine Reader, Omnipage 16)  
• Check your scanner documentation = scan to text or scan to OCR  
• Better with plain text 
• The more expensive the scanning engine the better it handles boxes, graphics & mixed formats.  

 



 

 

Trips, Tricks & Legalities with E-Text 
Keep E-Text book with hard copy.  Contact Publishers & ask for E-Text copy of books if you have hard 
copy (DDA).  Form a group with others who need E-Text copies. Encourage students with SLD to keep 
politely asking teachers for E-Text copy (USB drive). Encourage teachers to create an electronic copy of 
documents they create for class- save to intranet or flash drive.     
Extensions to E-Texts: - Make audio books; borrow audio books on MP3 Players . PDA books (most won’t 
read text aloud yet unless MP3 format).  Have good readers and writers make E-text or audio books  for 

the strugglers – good for both. Have older struggling readers & writers make e-texts for younger students.   
Teacher/ School Role    Provide: - Technology.  Text   Training 

Technology= Hardware , software, headsets , microphones 
Text = any work given in print should be available in electronic form.  Books, worksheets, tests, 

information etc. Pester suppliers to provide – (they have it). Use parent labour and tools/ home scanners 
to build up resources. Remember- save when you create.  Utilise web resources more (off line & online)  
Training Train whole class not just selected students.  Use computer room to teach skills then transfer to 

classroom usage. 
Skills: - Read   Select key points   Cut & paste (short cuts Ctrl+C, Ctrl+V or right click)  

Come from where kids are : - Most students whether able to “read” or not, are into technology. Watch 
what they do and work from where they are now - towards where they need to be . Use their love of 

technology. Don’t automatically condemn their means of communication because it is not as traditional as 
ours.   I-Pods are “cool” and “in”. They are also an excellent means of conveying information as audio 

books.  Texting can be the basis of an essay.  Blogs and Pods are a great way to encourage reluctant 
learners to contribute.  

Electronic literacy has the potential to level the learning playing field so that our understanding and ideas 
are what we are judged on, not our ability to decode or encode symbols.  The technology is ready and 
waiting.  Are we, the  educators, adaptable enough to accept the challenge? 
 
MICROSOFT READER a free download which will read text aloud 
First download the reader files:- ( about 15 mins on 56K modem) 
http://www.microsoft.com/reader/downloads/pc.asp  
Next download the text to speech feature which enables files to be read aloud: 
http://www.microsoft.com/reader/downloads/tts.asp 
The files need to be activated before they will work: http://www.microsoft.com/reader/info/activation.asp  
This contact will work on MS Word 2000 or above to convert word files to MS Reader files http:// 
http://www.microsoft.com/reader/downloads/rmr.asp 

After loading RMR.exe you may find the Microsoft Reader Icon is not showing when you turn on MS Word.  This 
means it has probably been disabled by MS Office.  To enable items that were disabled by Office Safe Mode  
• On the Help menu, click About Microsoft <application>.  
• Click Disabled Items. (You should see Read in Microsoft Word) 
• Select the items you want to enable.  
• Click Enable.  

With a MS Reader book open, right click on the page to see all the added functions you can use.  
This contact is for those who wish to get really involved in making e-books 
http://www.microsoft.com/reader/downloads/-partners.M  
Free Audio Books 
http://www.free-books.org/download/ch.php http://www.audiobooksforfree.com 
http://www.simplyaudiobooks.com/    (click free download tab – 1 free book a month)  
Study Notes Sites Great Sites for Help with Essays etc: ( Take care not to plagiarise)  
1 http://www.freebooknotes.com 
2 http://www.sparknotes.com/   
3 http://www.bookrags.com/browse/studyguides/  
4 http://www.bibliomania.com/1/frameset.html  

5 http://www.antistudy.com/   
6 http://www.cliffsnotes.com   
7 http://www.pivotalkids.com/fiction_activities.htm  

Rowan of Rin   (Google the name of a book – you may be surprised what you find.)  



 

 

http://www.google.com.au/search?hl=en&q=Rowan+of+Rin&meta=  
http://www.triv.net/html/Users11/u27353.shtml  http://www.multcolib.org/talk/guides-rowan.html
  
Free E- Text Books  Go to www.google.com and search for "etext public domain ebooks" or similar. You’ll find more 
URLs and books than you’ll have time to read. 
These URL’s were correct at time of printing but change frequently so some may not work.  
• www.bartleby.com  (ghost stories) 
• www.bibliomania.com/0/0/29/61/frameset.html  (classical texts, study guides secondary and tertiary) 
• http://www.baen.com/library/ 
• http://digital.library.upenn.edu/books/  (Mary Grant Bruce Billabong series) 
• http://www.promo.net/pg  Project Gutenberg  (various texts) 
• http://www.ipl.org/ (Internet Public Library – youth section) 
• http://www.awesomelibrary.org ( free to join for schools) 
• www.educationworld.com  
• www.elibrary.com (research and reference) 
• www.readinga-z.com (some free some subscription) 
• www.ipl.org/div/kidspace/storyhour  read on line or save individual pages 
• http://www.pitt.edu/~dash/folktexts.html#b electronic folk tales 
• www.gutenberg.net. 
• http://www.memoware.com/   
• http://gort.ucsd.edu  
• http://classics.mit.edu/ 
• http://utenti.tripod.it/libridigitali/publicdomain.htm 
• http://www.lib.utexas.edu/Libs/PCL/Etext.html  
• http://dmoz.org/Arts/Literature/Electronic_Text_Archives/ 
• http://www.readinga-z.com  on line talking readers  
• http://www.learningpage.com/free_pages/ewe_preview.html   free downloadable children’s books or read on line. 

Can copy into MS Reader.  
• http://www.bgfl.org  
• www.mightybook.com   some good stories but some have to be read online 
• www.ucalgary.ca/~dkbrown/storclas.html   classics - Jungle Book, White Fang, etc  
• http://bygosh.com/index.html    mostly fairy stories, online or select all/ copy/ paste to word or save as html 

doc.   
• www.cyberkids.com/lp/books.html  good 
• www.storiesfromtheweb.org/sfwhomepage.htm 
• www.bartleby.com  (ghost stories) 
• www.ipl.org/div/kidspace/storyhour  read on line or save individual pages  
• http://www.e-learningcentre.co.uk/eclipse/vendors/ebooks.htm  
• http://www.childrenslibrary.org/  
• http://en.wikibooks.org/wiki/Main_Page  
• http://www.google.com/Top/Kids_and_Teens/School_Time/English/Literature/Classics/ 
• http://www.eastoftheweb.com/short-stories/childrenindex.html  
Paid Sites (some free books ) Easiest way to find modern books. 
http://www.jiggerbug.com/default.php?cPath=43 
www.fictionwise.com 
http://www.audible.com/adbl/store/homepage_wg.jsp?BV_UseBVCookie=Yes&hwtab=1&switchTo=browseAudio   
www.powells.com/subsection/Microsoft ReaderChildrensYoungAdult.3.html  Pay & direct download. 
www.randomhouse.com/teachers/resources/ebooks.html  some free 
www.amazon.com/exec/obidos/tg/browse/-/509384/ref=br_bc_h_3/104-4541420-3076710     
 
Sample wording for letter to Publisher  
“Your book…… is one of the listed books for compulsory reading for my son/ daughter this year.  We 
have a hard copy of the book but because of a print disability my son/ daughter needs to access the text 
via a screen reader. As you will appreciate, scanning the books is a time consuming task.  Would your 



 

 

company please be able to provide an electronic copy of the book, preferably in plain text, or 
something accessible apart from PDF?”    
 
 
 


